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IN THE BOX

1. INTRODUCTION 

Thank you for purchasing the Celestron FlipView™ Handheld LCD Digital Microscope with a 5 MP sensor and flip out 3.0-

inch full color TFT LCD screen.  Your microscope is a precision optical instrument, made of the highest quality materials to 

ensure durability and long life. It is designed to give you a lifetime of pleasure with a minimal amount of maintenance.

FlipView provides low power viewing up to 120x using 
the built-in LCD screen. For additional magnification 
(up to 300x), connect the microscope to your PC. 
(Magnification depends on monitor size.)   

FlipView is a low magnification microscope, mainly 
suited for examining specimens like coins, stamps, rocks, 
electronics, insects, and other 3D objects. Specimens 
on slides can be viewed with top illumination, but this 
microscope is not ideal for this purpose. For high 
power viewing of slide specimens, see our full line of 
microscopes at Celestron.com.

FlipView does not use an eyepiece like a traditional 
microscope. Instead, the built-in camera sensor 
“sees” the specimen and the image is then displayed 
on the high-resolution color LCD screen. This makes 

viewing fun, reduces neck and eyestrain, and allows 
for easy sharing with others. You can also view on 
external monitors, projectors and TV screens with the 
included AV out cable.

Saving, transferring and sharing your image files is 
quick and easy with FlipView.  Save to your Micro SD 
card for transferring later, or use the included USB 
cable to directly connect to your computer.

Before attempting to use your microscope, please 
read through the instructions and reference the 
diagrams below. Take some time to read the simple 
care, maintenance, and troubleshooting tips in this 
manual to ensure that your FlipView microscope 
provides you with years of quality performance.

FlipView Handheld LCD 
Digital Microscope (1)

Carry bag (1)Metal stand (1)

AC Adapter (1) Lithium Battery (1) USB cable (1) Video Out cable (1)

CD (1) QSG (1) Cleaning Fabric (1) Calibration Ruler (1)                 
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PARTS

1.   Shutter trigger

2.   Flip out LCD screen

3.   Flip out leg 

4.   Settings button

5.   Color mode button/up button

6.   Playback/left button

7.   Illuminator adjustment wheel 

8.   Battery compartment

9.   Zoom control button

10. 5 V AC in port

11. Mini USB port 

12. Video out port

13. Micro SD card slot

14. Battery charge indicator

15. OK button

16. Down button

17. On/Off switch

18. Focus wheel

19. Microscope barrel

20. ¼-20” threaded insert
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2. SETUP

INSTALL BATTERY

Open the battery compartment (8) and insert the battery, 
making sure to align the connection points correctly.

NOTE:  FlipView’s battery ships with a partial charge. However, if you are going to use the 
microscope with the battery only, be sure to charge the battery fully before the 
first use. 

SPECIFICATIONS

Magnification Range 10x-120x (up to 300x when using PC)

Sensor 5 MP CMOS 1/3.2  in

LCD screen 3.0-inch full color TFT LCD screen (hinges in both X (90°) and Y (180°) axes)

Lens 5 element IR Cut (infrared reducing) high quality glass lens  
Effective Focal Length: 15.8 mm 
Image distortion: 0.10% 
FOV: 13.0°

Focuser Range Manual focus from 10 mm to 300 mm

Illumination 8 adjustable white LEDs in ring configuration 

Shutter trigger On housing 

Still Image Resolution 5 MP, 3 MP, 1.3 MP, VGA  (12 MP interpolation)

Video Capture Resolution VGA, 30 fps

Video Compression Format MJPEG

Video Output Video out cable (included)

PC connection Interface USB 2.0 cable (included)

OS systems supported Windows XP/Vista/7/8
Mac OSX 10.6-10.9

Memory Micro USB card slot (supports up to 32 GB) (Micro SD card NOT included)

Power Internal rechargeable lithium ion battery (1050 mAh)
AC adapter universal input 100 to 240 volt 50/60 Hz (44315- EU version has multi-plug)

Measuring Software Celestron Portable Capture Pro software with note taking capabilities. Calibration tool 
included.

Software languages supported English, German, French, Spanish, Russian, Italian, Portuguese, Dutch, Japanese, Korean, 
Chinese

Dimensions Microscope: 4.625 in x 2.5 in x 4.25 in (117.5 mm x 63.5 mm x 108 mm)
Stand: 3.0 in x 1.75 in x 2.75 in (76.2 mm x 44.5 mm x 70 mm)

Weight Microscope: 7.4 oz/212 g
Microscope and stand: 11.2 oz/317 g

NOTE: Interpolation refers to software adding pixels to an image to artificially make it larger. This can be beneficial when printing in larger formats. 

CHARGING THE BATTERY

•  Plug the small end of the power adapter into the 5 V/AC in 
port (10) on the back of the microscope. Plug the other end 
into a standard AC wall outlet.

*  The battery charge indicator LED (14) will light up red to show 
the battery is charging.

*  When battery is fully charged, the battery charge indicator 
LED will turn off. You can now unplug FlipView and use it 
without an external power source for up to 2 hours. 

*  You can monitor the battery power level on the LCD screen.  
Look for the battery power indicator icon described later in this 
section.

1050m
Ah
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INSERT MICRO SD CARD

To capture images with your microscope while not 
connected to a computer, insert a Micro SD card in the 
card slot (13) on the back of the unit. Press firmly until 
the card clicks into place.

NOTE:  A MicroSD card is NOT included. To capture images without a MicroSD 
card, see section 7 in this manual for instructions on installing the computer 
software and saving images directly to your  computer.

NOTE:  Format your MicroSD card before use. See section 4 for details on formatting 
the card.

DISPLAY ICONS

NOTE: The display icons can be turned off by pressing down on the zoom control button

MicroSD Card Recognized

Video Capture Setting

Current Resolution Setting

Battery Power Indicator

Small Image Capture

Video Capture

Time Lapse Capture

Number of Images Taken/Number of 
Images Remaining 

Video Capture Time Remaining 
(Hours:Minutes:Seconds)
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3.  OBSERVING AND CAPTURING IMAGES:  
DIGITAL IMAGING 

VIEW A SPECIMEN

Power FlipView on and aim it at your specimen. Adjust the 
illuminator by rotating the illuminator adjustment wheel (7). 
Adjust the focus wheel (18) until the specimen is in focus.

CAPTURE AN IMAGE 

To capture a still image, press the shutter trigger (1).

CHANGE MODE

To toggle between still image, video and preview modes, press 
the playback button (6). From still image press twice to get to 
video mode.   To determine the current mode, look for the icons 
in the upper left corner of the LCD screen.  

CHANGE COLOR MODE: 

To change between color, negative and B&W streaming preview  
modes, press the color mode button (5).

A. B. C.
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ADJUST DIGITAL ZOOM: 

When observing your specimen, you can zoom in and out using the 
zoom control button (9)

CAPTURE VIDEO: 

In video mode, press the shutter trigger (1) to start recording. Press 
it again to stop recording.

REVIEW IMAGES

Press the playback button (6) once from still image mode or twice 
from video mode.  Videos and still images will be displayed with the 
last image or video displayed first.  Press the up button (5) or down 
button (16) to scroll through images/videos.  

PREVIEW VIDEO

When a video file is displayed, press the OK button (15) to start the 
video. Press it again to stop the video.

DELETE IMAGES 

To delete a still image or video file, press the setup button (4) to 
bring up the menu. Press the down button (16) to scroll to “Delete.” 
Press OK.  

You will prompted to select “This Image” or “All.” Use the down button 
again to scroll through the choices and select OK. You will be asked 
one more time if you want this to be completed. Select “Execute.” 
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PROTECT IMAGES

This feature protects images or videos from being deleted 
from the MicroSD card. To protect an image or video file, 
press the the setup button (4) to bring up the menu. Press 
the down button (16) to scroll to “Protect.” Press OK. Follow 
the prompts and select “OK” when done.

 

SLIDE SHOW 

 Use this feature to preview all the images on the SD card.  
Use the buttons to choose the desired interval between 
images.
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4.  SOFTWARE MENU INTRODUCTIONS

MENU   

From the preview mode, press the setup button (4)   to enter 
the main menu. The menu choices will vary depending on the 
mode you are in: still image or video. Use the down button (16), 
the up button (5) and the OK button(15) to navigate the menu.

When in still image mode, you will see the following settings:

1. Resolution

2. Time Lapse

3. Quality

4. Sharpness

There is only one setting in video mode:

1. Resolution

RESOLUTION SETTINGS

In still image mode, the choices are: 

1. 12.0 MP (interpolated*) 

2. 9.0 MP 

3. 5.0 MP 

4. 3.0 MP

5. 1.3 MP

6. VGA

TIME LAPSE

FRAMES: Sets the number of frames to capture.

INTERVAL: Sets the interval between shots.

Once you have made your selections, press OK to confirm and 
press the menu button to go back to preview mode.

                                                            

NOTE: The number above represents 32 frames.
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NOTE: The number above represents 15 seconds.

 When you press the capture button, the icon will be displayed in 
the upper left corner of the LCD screen.

 When all the frames have been taken, FlipView will return to the 
preview screen.

 To stop the auto capture before it completes, press the capture 
button once.

NOTE:  The time lapse setting only works in still image mode.

QUALITY

The quality settings determine the level of image compression. The 
more compression you use, the less detail the image will contain, 
and the smaller the file size will be.

There are 3 choices in the quality setting window:

1.  Super Fine (largest files, least compressed, most detail) 

2.  Fine

3.  Normal (smallest file, most compressed)

SHARPNESS

Sharpness increases the differences the imaging process detects 
between the edges of the pixels.  There are no rules when it 
comes to the sharpness settings. Experiment to find out which 
works best for your specimens.

The 3 choices for sharpness are:

1. Hard 

2. Normal

3. Soft
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SETUP MENU

While in the main menu press the playback button (6) button to enter 
setup. The choices here are:

1. Language

2. Power Save 

3. Frequency        

4. Date Stamp

5. TV out 

6. Date/Time

7. Format SD

8. System Reset

9. Version

LANGUAGE

FlipView supports 11 languages: 

1. English

2. German

3. French

4. Spanish

5. Italian

6. Portuguese

7. Japanese

8. Simples Chinese

9. Traditional Chinese

10. Dutch   

11. Russian

 Use the arrow buttons to scroll to your language preference and  
press OK (15) to save.

POWER SAVE

Power save mode conserves battery power by setting the unit to turn 
off automatically.  The choices for times are:

1. OFF - Power Save feature is off; unit will not turn off automatically

2. 5 min. - Unit will turn off after 5 minutes of non-use

3. 10 Min. - Unit will turn off after 10 minutes of non-use

4. 15 Min. - Unit will turn off after 15 minutes of non-use

5. 30 Min. - Unit will turn off after 30 minutes of non-use

FREQUENCY

This setting has to do with your TV’s refresh rate. For USA (NTSC), 
use 60Hz; for others, use 50Hz.
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DATE STAMP

If you wish, you can display a date stamp on image files (but not on 
video files).

The choices are:

1.  DATE/TIME: Displays both DATE and TIME on the saved image 
file

2. DATE: Displays only the date on the image file

3. OFF: Will NOT display any DATE/TIME information

TV OUT

 Set your TV out setting to either NTSC or PAL, depending on your 
location. 

1. Choose NTSC for 

• North America

•  South America (excluding Brazil, Argentina, Uruguay and  
French Guiana)

• Myanmar, South Korea, Taiwan, Japan and the Philippines

2. Choose PAL for all other countries     

NOTE:  See map below

NOTE:  The DATE and/or TIME will NOT be displayed in the preview mode-  
only on the recorded image file.
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DATE/TIME

Here you can set the correct time of day and determine how the time will 
be displayed. 

Choose from the following options:

1. YY/MM/DD

2. DD/MM/YY

3. MM/MM/DD

FORMAT MICRO SD CARD

Choose this option to format your Micro SD card. We recommend always 
formatting Micro SD cards before using them with FlipView for the first time. 
Formatting the card will erase all other data it contains. 

SYSTEM RESET

Choose this option to return FlipView to its default factory settings.

VERSION

The version screen will display information on your firmware version.  
No changes can be made here.

5.  TRANSFER FILES TO COMPUTER
+   Connect FlipView to your computer using the USB cable provided.

+   Choose “Upload Images” on the LCD screen by pressing the OK button (15).

+   Your computer will now read the Micro SD card like a digital camera and download 
the images your PC.

+   When the transfer is complete, you can open and view the images on your PC using 
your favorite software.

6.  CONNECT TO TV
+  Insert the 1/8-inch plug on the end of the supplied AV cable into FlipView’s AV out port 

(12) on the back of the unit.

+  Insert the yellow RCA plug on the video cable into the TV or projector’s yellow video 
input connectors.

+  Turn on the television or projector. Be sure your television is tuned to the appropriate 
input channel.

+  You should now see an image of the specimen you are viewing. 
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1.  Install Software.  Using the included CD, install the software on 
your computer.  You may need to restart your computer before 
launching software for the first time.

2.  Connect FlipView to your computer using the USB cable provided 
as described above..

3.  Choose “Preview on Computer” on the LCD screen, by pressing 
the OK button (15).

4.  Open the Celestron Portable CapturePro Software on your PC by 
clicking the desktop icon. 

5. View the streaming image in the software interface.

NOTE:  Once the software is launched, the LCD screen will go blank. You will now control the 
microscope from the computer. However, you will still control focus, zoom and illumination 
manually on the device.

NOTE:  When you connect to the PC via USB, FlipView’s internal lithium ion battery will begin 
charging.

NOTE:   If the microscope does not connect, the following error message will be displayed: “No 
device detected. Please connect your microscope directly to an open USB port.” Try 
restarting the software.

8. USING THE SOFTWARE

CAPTURE A STILL IMAGE AND VIDEO

+   To capture a still image, click on the capture menu and select 
Photo.

+   To begin recording video, click on the Capture menu and scroll 
down to Video. Repeat to stop recording.

+   You should now see an image of the specimen you are viewing.

OTHER MENU ITEMS

FILE MENU  Under the File menu item, you will find:

PHOTOS  DIRECTORY:  Directs you to a folder on 
your hard drive to save still images.

VIDEOS  DIRECTORY:  Directs you to a folder on 
your hard drive to save videos.

EXIT:  Closes the software.

7.  USING THE CELESTRON PORTABLE CAPTURE  
PRO SOFTWARE
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OPTIONS: Under the Options menu item, you will find: 

 RESOLUTION: Sets the sensor image resolution. Choose from 2 resolution settings:

  - 320 x  240

  - 640 x 480

NOTE:  When connected to a PC, FlipView cannot capture high-resolution images, but can be used for demonstration and streaming. To take advantage of full 5 MP resolution, unplug FlipView 
from the computer.

 DATE/TIME: Turns the Date and Time stamp on or off.

 LANGUAGE:  Changes the language setting. Choose from 12 languages:

  -  English, German, French, Spanish, Russian,  
Italian, Portuguese, Dutch, Polish, Japanese, Korean and Chinese

  X,Y RETICLE:  Turns the reticle guide on the preview screen on or off.

 FULL SCREEN MODE:  Uses the full screen of your monitor. Press Esc key to revert back.

ICONS:   Along with the menu items, there are icons which mean the following:

 A. Take a still image (photo)

  B. Start videos/stop video

 C. Full screen mode
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+  The Celestron Portable CapturePro software includes a 
measurement feature. To use this feature, you must first 
perform a measurement calibration.

+  Make sure the X,Y Guide is set to “On” by selecting it in  
the Options Menu.

+  Double click the saved image to open it in the Image 
Preview screen.

+  Take a still image. The image will be displayed in the 
column on the right side of the screen.

+ Click on the Calibration icon 

+  Click and drag a line across a “known value” on the ruler image. 
Try to keep the line as perpendicular to the lines on the ruler as 
possible.

+  The “Adjust magnification” window will pop up as shown here.

+  In the box “Actual Dimension”, enter the “known value” from the 
calibration ruler

+  Set the height of the microscope and focus on your 
specimen. Then, replace your specimen with the 
calibration ruler.

+  Re-adjust the focus and align the calibration ruler so that 
the lines on the ruler are parallel with the vertical line on 
the X,Y Guide.

9. CALIBRATION AND MEASUREMENT
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+  To ensure that calibration was successful, go back to the Image 
Capture screen.

+  Click the ruler icon   and from the dropdown menu 
select the option “Any Angle Line”

+  Click and drag a line across the same “known value” as before. 

+  If the calibration was successful, the distance you measured 
should be exact to the “known value”

+  To capture images without changing the height or magnification, 
click on the Calibration icon. In the dropdown menu, select “Set 
Magnification,” then “Set Capture Magnification.”  

+  A pop-up window will appear. Type in the magnification shown in 
the upper right corner of the main window.

MEASURING TOOLS

You will notice in the measuring drop down menu there are many 
tools.  Here is the list of measurements you can take:

 MAIN

 1.  Any Angle:  Measures from point A to point B in a 
straight line.

 2.  Continuous Line:  Measures the total distance 
between multiple points. Start by measuring a straight 
line from point A to point B. Then, click and drag to 
continue measuring from point B to point C. (Can be 
repeated as many times as you like.)

 3.  Radius Circle:  Measures a circle’s radius.  Starting at 
the center, drag the cursor out to any edge.

 4.  Diameter Circle:  Measures a circle’s diameter.  
Starting at one outside edge, drag the cursor across to 
the opposite edge.

 5.  Three Point Angle:  Measures an angle between two 
points, starting from a radius point or an intersection 
point. Click on point A, (radius point) drag and click on 
point B, then click on point C.  The angle will be drawn 
and the angle degree will be displayed.

 SETTINGS

 1.  Line Properties: Changes the settings for line type, 
width, size and color.

 2.  Text Properties: Changes the settings for font type, 
size, style and color.

 3.  Set Units: Changes the units setting. Choose from 
millimeters, centimeters, pixels or inches.
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Portable CapturePro includes functionality to mark, draw on, or and add notes to saved images. This can be handy for 
quick note taking and pointing out features on your specimen image.

1. MARKING

 +  To use this feature, click the Draw icon    in the Image Preview window.

 +  The complete choices in the Draw dropdown menu are:

 MAIN

 1. Line:  Draws a straight line on the image.

 2. Arrow:  Draws a line with an arrow on the image.

 3.  Freehand:  Allows user to draw freehand. Good for quick, handwritten notes. 

 4.  Rectangle:  Draws a box. Good for calling out features on the image or framing text.

 SETTINGS

 1. Line Properties: Allows for setting the line type, size and color

2. ADD TEXT

 +  To type notes on the image, select the Type icon 

 +  In the dropdown menu, you can choose the font type, size and color.

TAKING NOTES AND MARKING THE IMAGE
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A. Save: Save your file

B. Copy to clipboard: Copy to open in other program

C. Copy: Save as a copy

D.  Previous: Takes you back to the previous image  
in save folder 

E.  Next: Takes you forward to the next image in  
save folder 

F. Undo: Takes you back one step

G. Redo: Takes you forward one step

H. Draw

I. Text/Notes

J. Measure

K. Calibration

L. Current Magnification (based on the latest calibration)

A.

B.

C.

D.

E.

F.

G.
H.

I.

J.

K.

L.

IMAGE PREVIEW ICONS EXPLAINED

10. MULTI-PLUG
If you have purchased your FlipView outside of North America 
(model 44315), you will notice a multi-plug AC adapter. 
There are 3 interchangeable plug heads that will fit outlets in 
Europe, the United Kingdom/Hong Kong and China.

To change the plug head: 

 -  Grasp the main plug housing with one hand  
and the plug head of choice with the other.

 -  Press the small button release on the plug  
housing (circled in below image).

 -  Locate and interlock the tabs on the plug head 
with the grooves on the plug housing.

 -  Rotate the plug head clockwise 90° until you  
hear a “click” as the plug head locks into place

To remove the plug head, press the small button release and 
rotate the plug head counterclockwise until it releases.
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11. CARE  AND MAINTENANCE 
Your microscope with digital camera is a precision optical instrument and should be treated with care at all times. Follow these 
care and maintenance suggestions and your microscope will need very little maintenance throughout its lifetime.

+ Store your microscope in a dry, clean place.

+  Never use your microscope where operation of such 
devices is restricted.  Improper use creates the risk of 
serious accident.

+  Do not try to access the internal components of your 
microscope or attempt to modify it in any way.  Only 
authorized technicians should perform maintenance  
or repairs.

+  Keep your microscope away from water and other liquids. 
Never use it in the rain or snow. Moisture creates the danger 
of fire and electric shock.

+  To clean dust or smudges from the LCD screen or other 
optical component, first blow the dust off with a camel’s hair 
brush or air blower. Then use the included dry, microfiber 
cloth to wipe the surface.

+  If the exterior surfaces of your microscope need cleaning, 
wipe with a moist cloth.

12. TROUBLESHOOTING

PROBLEMS SOLUTION
The unit does not turn on. Check the battery power. If necessary, recharge by plugging into AC power.

The screen is blank. + Ensure that the power is on.
+ Check the battery power and recharge the battery if necessary.
+ Verify that the object you want to magnify is positioned correctly under the lens.
+ Make sure the illuminator is ON

There are smudges or blemishes on the 
screen.

+ Clean the screen and lens carefully with the included microfiber cloth.

Microscope is connected to a television, but 
no image appears on the television screen.

+ Ensure that the television is on.
+  Switch to the appropriate video input channel on your television. (This will vary by 

manufacturer.)
+  Ensure that the video cable is securely connected to the microscope’s Video Out port  

and plugged into the correct video input on your television

The battery indicator LED is not illuminating, 
even though the power adapter is connected 
and plugged into a wall socket.
-or-
The battery is not charging.

+  Make sure the cable is plugged into the proper port.

+  Check that the outlet has power and is not malfunctioning. If the outlet is connected  
to a wall switch, make sure that the switch is on.

13. WARRANTY 
Your FlipView  LCD Microscope has a two year limited warranty. Please visit the Celestron website for detailed  
information on all Celestron microscopes:  

© 2014 Celestron • All rights reserved.  •   celestron.com 
2835 Columbia Street • Torrance, CA 90503 U.S.A. 
Telephone: 1(800) 421-9649 • Printed in China 2013

FCC Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

+ Reorient or relocate the receiving antenna.
+ Increase the separation between the equipment and receiver.

+  Connect the equipment into an outlet on a circuit different from 
that to which the receiver is connected.

+ Consult the dealer or an experienced radio/TV technician for help.

This product is designed and intended for use by those 14 years of age and older. Product design and specifications are subject to change without prior notification. 44314, 44315


